
Lecture 8: 
Intro to Assembly 
Programming
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The MIPS Microprocessor



Intro to Machine Code
§ Now that we have a processor, operations are 

performed by:
ú The instruction register sends instruction components 

to the control unit. 
ú The control unit  decodes instruction according to the 

opcode in the first 6 bits.
ú The control unit sending a sequence of signals to the 

rest of the processor.

§ Only questions remaining:
ú Where do these instructions come from?
ú How are they provided to the instruction memory?



Machine Code Instructions



A little about MIPS

§ MIPS
ú Short for Microprocessor without Interlocked 

Pipeline Stages
  A type of RISC (Reduced Instruction Set Computer) 

architecture.

ú Provides a set of simple and fast instructions
  Compiler translates instructions into 32-bit 

instructions for instruction memory.
  Complex instructions are built out of simple ones by 

the compiler and assembler.



MIPS Memory and Instructions

§ All memory is 
addressed in bytes.

§ Instruction addresses are measured in bytes, 
starting from the instruction at address 0.

§ All instructions are 32 bits (4 bytes) long
§ Therefore:

all instruction addresses are divisible by 4.



Recall: MIPS instruction types

§ R-type:

§ I-type:

§ J-type:

opcode rs rt

6 5

rd

5

shamt

5

funct

5 6

opcode rs rt

6 5

immediate

5 16

opcode address

6 26



MIPS Registers
§ In MIPS is register-to-register (a.k.a. load-store) architecture

ú Source, destination of ALU operations are registers.

§ MIPS provides 32 registers. 
ú Some have special values:

  Register 0 ($zero): value 0 – always  (writes to it are discarded)
  Register 1 ($at): reserved for the assembler.
  Registers 28-31 ($gp, $sp, $fp, $ra): memory and function support
  Registers 26-27: reserved for OS kernel

ú Some are used by programs as functions parameters:
  Registers 2-3 ($v0, $v1): return values
  Registers 4-7 ($a0-$a3): function arguments

ú Some are used by programs to store values:
  Registers 8-15, 24-25 ($t0-$t9): temporaries
  Registers 16-23 ($s0-$s7): saved temporaries

ú Also three special registers (PC, HI, LO) that are not directly accessible.
  HI and LO are used in multiplication and division, and have special 

instructions for accessing them.



Assembly Language Introduction



Assembly vs Machine Code

§ Each processor type has its own language for 
representing 32-bit instructions as user-
readable code words.

§ Example: C = A + B
ú Assume A is stored in $t1, B in $t2, C in $t3.
ú Assembly language instruction:

ú Machine code instruction:

add $t3, $t1, $t2

000000 01001 01010 01011 XXXXX 100000

Note: There is a 1-

to-1 mapping for 

all assembly code 

and machine code 

instructions!



Assembly language
§ Assembly language is the

lowest-level language that
you’ll ever program in.

§ Many compilers translate
their high-level program
commands into assembly commands, which 
are then converted into machine code and 
used by the processor.

§ Note: There are multiple types of assembly 
language, especially for different architectures!



Why learn assembly?

§ Understand how code really works
§ Better analyze code (runtime, control flows, 

pointers, stack overflows)
§ Make you appreciate constructs of high level 

languages
§ Connect your high level programming 

knowledge to hardware
§ It's on the exam…



Arithmetic instructions
Instruction Opcode/Function Syntax Operation

add 100000 $d, $s, $t $d = $s + $t

addu 100001 $d, $s, $t $d = $s + $t

addi 001000 $t, $s, i $t = $s + SE(i)

addiu 001001 $t, $s, i $t = $s + SE(i)

div 011010 $s, $t lo = $s / $t; hi = $s % $t

divu 011011 $s, $t lo = $s / $t; hi = $s % $t

mult 011000 $s, $t hi:lo = $s * $t

multu 011001 $s, $t hi:lo = $s * $t

sub 100010 $d, $s, $t $d = $s - $t

subu 100011 $d, $s, $t $d = $s - $t

Note: “hi” and “lo” refer to the high and low bits referred to in the register slide.
“SE” = “sign extend”.



Assembly à Machine Code

Instruction Opcode/Function Syntax Operation

add 100000 $d, $s, $t $d = $s + $t

opcode rs rt rd shamt funct000000 01001 01010 01011 XXXXX 100000

t3 = t1 + t2; add $t3, $t1, $t2

R-type 
instruction!

Operation Assembly

Although we specify “don’t care” bits as X values, the assembler 
generally assigns some value (like 0).



Logical instructions

Instruction Opcode/Function Syntax Operation

and 100100 $d, $s, $t $d = $s & $t

andi 001100 $t, $s, i $t = $s & ZE(i)

nor 100111 $d, $s, $t $d = ~($s | $t)

or 100101 $d, $s, $t $d = $s | $t

ori 001101 $t, $s, i $t = $s | ZE(i)

xor 100110 $d, $s, $t $d = $s ^ $t

xori 001110 $t, $s, i $t = $s ^ ZE(i)

Note: ZE = zero extend (pad upper bits with 0 value).



Assembly à Machine Code II

Instruction Opcode/Function Syntax Operation

andi 001100 $t, $s, i $t = $s & ZE(i)

opcode rs rt immediate001100 01001 01010 0000000000101010

t2 = t1 & 42; andi $t2, $t1, 42

I-type 

instruction!

Operation Assembly



Shift instructions

Instruction Opcode/Function Syntax Operation

sll 000000 $d, $t, a $d = $t << a

sllv 000100 $d, $t, $s $d = $t << $s

sra 000011 $d, $t, a $d = $t >> a

srav 000111 $d, $t, $s $d = $t >> $s

srl 000010 $d, $t, a $d = $t >>> a

srlv 000110 $d, $t, $s $d = $t >>> $s

Note: srl = “shift right logical”
sra = “shift right arithmetic”.
The “v” denotes a variable number of bits, specified by $s.
a is shift amount, and is stored in shamtwhen encoding
the R-type machine code instructions.



Data movement instructions

Instruction Opcode/Function Syntax Operation

mfhi 010000 $d $d = hi

mflo 010010 $d $d = lo

mthi 010001 $s hi = $s

mtlo 010011 $s lo = $s

§ These are instructions for operating on the HI and 
LO registers described earlier (for multiplication and 
division) 



ALU instructions in RISC
§ Most ALU instructions are R-type instructions.

ú The six-digit codes in the tables are therefore the 
function codes (opcodes are 000000).

ú Exceptions are the I-type instructions (addi, 
andi, ori, etc.)

§ Not all R-type instructions have an I-type 
equivalent.
ú RISC principle dictate that an operation doesn’t 

need an instruction if it can be performed through 
multiple existing operations.

ú Example:  addi + divà divi



Pseudoinstructions

§ Move data from $t4 to $t5?
ú move $t5,$t4 à

§ Multiply and store in $s1?
ú mul $s1,$t4,$t5 à

add $t5,$t4,$zero

mult $t4,$t5
mflo $s1



Time for a Break

Bill Watterson: Calvin & Hobbes



Making an assembly program

§ Assembly language programs typically have 
structure similar to simple Python or C 
programs:
ú They set aside registers to store data.
ú They have sections of instructions that manipulate 

this data.

§ It is always good to decide at the beginning 
which registers will be used for what purpose!
ú More on this later J



Time to write our 
first assembly program



Compute result = a2 + 2b + 10
§ Set up values in registers

ú a à $t0, b à $t1
ú temp à $t6

§ temp  = 10

§ temp = temp + b
§ temp = temp + b (again!)

§ result = a*a

§ result = result + temp

addi $t0, $zero, 7
addi $t1, $zero, 9

addi $t6, $zero, 10

add $t6, $t6, $t1
add $t6, $t6, $t1

mult $t0, $t0
mflo $t4
mfhi $t5

add $t4, $t4, $t6



Formatting Assembly Code

§ Instruction are written
as:    <instr> <parameters>

§ Each instruction is written on its own line
§ 3 columns

ú Labels
ú Code
ú Comments

§ Start with .text (we’ll see other options later)
§ First line of code to run = label: main



# Compute the following result: r = a^2 + 2b + 10

.text
# load up some values to test
main: addi $t0, $zero, 7

addi $t1, $zero, 9
# $t0 will be a,   $t1 will be b,   $t5:$t4  will be r
# $t6 will be temp

addi $t6, $zero, 10 # add 10 to r
add $t6, $t6, $t1 # then add b
add $t6, $t6, $t1 # then add b again
mult $t0, $t0 # multiply a * a
mflo $t4 # move the low result of a^2

# into the low register of r
mfhi $t5 # move the high result of a^2

# into the high register of r
add $t4, $t4, $t6 # add the temporary value 

# (2b + 10) to the low
# register of r



aka: QtSpim

Simulating MIPS



QtSpim Simulator

§ Link to download: 
ú http://spimsimulator.sourceforge.net

§ MIPS settings in the simulator:
ú From menu, Simulator à Settings
ú Important to not have “delayed branches” or 

“delayed loads” selected under Settings.
ú “Load exception handler” field should also be 

unchecked.

§ You should view user code (Text Segment -> 
User text), no need for “kernel text”

http://spimsimulator.sourceforge.net/


QtSpim Settings



QtSpim – Quick How To

§ Write a MIPS program (similar to the ones 
posted) in any text editor. Save it with .asm
extension.

§ In QtSpim select: 
ú File -> Reinitialize and load a file
ú Single step through your program while observing 

(a) the Int Regs window and (b) the text window 
(user text).
  As you step through, the highlighted instruction is 

the one about to be executed.



QtSpim Help => MIPS reference

§ QtSpim help (Help -> View Help) contains
ú “Appendix A (Assemblers, Linkers, and the SPIM Simulator)”    

from Patterson and Hennessey, Computer Organization and Design: 
The Hardware/Software Interface, Third Edition

ú Useful reference for MIPS R2000 Assembly Language
  Look at “Arithmetic and Logical Instructions”.



r = (2a + 5) * (7b) 
.text
# $t0 = a, $t1 = b, $t4 = r
# $t7 = left side, $t8 = right side
main: addi $t0, $zero, 7 # load up some values to test

addi $t1, $zero, 9
# calculate left side
calc_left: add $t7, $t0, $t0 # ls <- 2a

addi $t7, $t7, 5 # ls <- ls + 5

# calculate right side
calc_right: addi $t8, $zero, 7 # rs <- 7

mult $t8, $t1 # multiply b * 7
mflo $t8 # put result back into rs

# multiply left * right and put result into r
mulitply: mult $t7, $t8

mflo $t4



Control Flow



Control flow in assembly

§ Not all programs follow a linear set of instructions.
ú Some operations require the code to branch to one 

section of code or another (if/else).
ú Some require the code to jump back and repeat a section 

of code again (for/while).

§ For this, we have labels on the left-hand side that 
indicate the points that the program flow might 
need to jump to.
ú References to these points in the assembly code are 

resolved by the assembler at compile time to offset 
values for the program counter.



Time for more 
instructions! 



Branch instructions

Instruction Opcode/Function Syntax Operation

beq 000100 $s, $t, label if ($s == $t) pc ß label

bgtz 000111 $s, label if ($s > 0) pc ß label

blez 000110 $s, label if ($s <= 0) pc ß label

bne 000101 $s, $t, label if ($s != $t) pc ß label

§ Branch operations are key when implementing if 
statements and while loops.

§ The labels are memory locations, assigned to each 
label at compile time.



Branch instructions

§ How does a branch instruction work?

.text

main:   beq $t0, $t1, end # check if $t0 == $t1 
... # if $t0 != $t1, then
...                 # execute these lines

end: ... # if $t0 == $t1, then
... # execute these lines



Branch instructions

§ Alternate implementation using bne:

§ Used to produce if statement behaviour.

.text

main:   bne $t0, $t1, end # check if $t0 == $t1 
... # if $t0 == $t1, then
...                 # execute these lines

end: ... # if $t0 != $t1, then
... # execute these lines



Conditional Branch Terms

§ When the branch condition is met, we say the 
branch is taken.

§ When the branch condition is not  met, we 
say the branch is not taken.
ú What is the next PC in this case?

  It’s the usual PC+4

§ How far can a processor branch? Are there 
any constraints?



Jump instructions

Instruction Opcode/Function Syntax Operation

j 000010 label pc ß label

jal 000011 label $ra = pc; pc ß label

jalr 001001 $s $ra = pc; pc = $s

jr 001000 $s pc = $s

§ jal = “jump and link”. 
ú Register $31 (aka $ra) stores the address that’s used when 

returning from a subroutine.

§ Note: jr and jalr are not j-type instructions.



Comparison instructions

Instruction Opcode/Function Syntax Operation

slt 101010 $d, $s, $t $d = ($s < $t)

sltu 101001 $d, $s, $t $d = ($s < $t)

slti 001010 $t, $s, i $t = ($s < SE(i))

sltiu 001001 $t, $s, i $t = ($s < SE(i))

§ “slt” = “Set Less Than”
§ Comparison operation stores a one in the destination 

register if the less-than comparison is true, and stores a 
zero in that location otherwise.

§ Signed: 0x8000000 is less than all numbers
§ Unsigned: 0 - 0x7FFFFFFF are less than 0x8000000



If/Else statements in MIPS

§ Strategy for if/else statements:
ú Test condition, and jump to if logic block 

whenever condition is true. 
ú Otherwise, perform else logic block, and jump to 

first line after if logic block.

if ( i == j )
i++;

else
j--;

j += i;



Translated if/else statements

§ Alternately, you can branch on the else 
condition first:

#  $t1 = i, $t2 = j
main: beq  $t1, $t2, IF # branch if ( i == j ) 

addi $t2, $t2, -1 # j--
j END           # jump over IF

IF: addi $t1, $t1, 1 # i++
END: add $t2, $t2, $t1 # j += i 

#  $t1 = i, $t2 = j
main: bne  $t1, $t2, ELSE   # branch if ! ( i == j ) 

addi $t1, $t1, 1      # i++ 
j END                 # jump over ELSE

ELSE: addi $t2, $t2, -1     # j--
END: add $t2, $t2, $t1     # j += i 



A trick with if statements

§ Use flow charts to help you sort out the 
control flow of the code:

if ( i == j )
i++;

else
j--;

j += i;

#  $t1 = i, $t2 = j
main: beq  $t1, $t2, IF

addi $t2, $t2, -1
j END           

IF: addi $t1, $t1, 1 
END: add $t2, $t2, $t1 

beq

else 
block

if 
block

end

true
false

jump



Multiple Conditions Inside If
if ( i == j || i == k )

i++ ;  // if-body 
else

j-- ;  // else-body 
j = i + k ;



Multiple Conditions Inside If

§ Branch statement for each condition:

if ( i == j || i == k )
i++ ;  // if-body 

else
j-- ;  // else-body 

j = i + k ;

#  $t1 = i, $t2 = j, $t3 = k
main: beq $t1, $t2, IF     # cond1: branch if ( i == j ) 

bne $t1, $t3, ELSE   # cond2: branch if ( i != k ) 
IF: addi $t1, $t1, 1   # if (i==j|i==k) à i++ 

j END              # jump over else 
ELSE: addi $t2, $t2, -1  # else-body: j--
END: add $t2, $t1, $t3  # j = i + k 



Multiple if conditions
§ How would this look if the condition changed?

if ( i == j && i == k )
i++ ;  // if-body 

else
j-- ;  // else-body 

j = i + k ;

#  $t1 = i, $t2 = j, $t3 = k
main: bne $t1, $t2, ELSE   # cond1: branch if ( i != j ) 

bne $t1, $t3, ELSE   # cond2: branch if ( i != k ) 
IF: addi $t1, $t1, 1   # if (i==j|i==k) à i++ 

j END              # jump over else 
ELSE: addi $t2, $t2, -1  # else-body: j--
END: add $t2, $t1, $t3  # j = i + k 



main: add $t0, $zero, $zero
addi $t1, $zero, 100

START: beq $t0, $t1, END
addi $t0, $t0, 1
j START

END:



Loops in MIPS
§ Example of a simple loop, in assembly:

§ …which is the same as saying (in C):

main: add $t0, $zero, $zero
addi $t1, $zero, 100

START: beq $t0, $t1, END
addi $t0, $t0, 1
j START

END:

int i = 0;
while (i < 100) {

i++;
}



Loops in MIPS

§ For loops (such as above) are usually 
implemented with the following structure:

for ( <init> ; <cond> ; <update> ) {
<for body>

}

main: <init>
START: if (!<cond>) branch to END 

<for-body> 
UPDATE:  <update> 

jump to START 
END:



Loop example in MIPS

§ This translates to:

§ while loops are the same, without the 
initialization and update sections.

j = 0; 
for ( i=0 ; i<100 ; i++ ) {

j = j + i;
}

#  $t0 = i, $t1 = j
main: add $t0, $zero, $zero # set i to 0

add $t1, $zero, $zero # set j to 0
addi $t9, $zero, 100 # set $t9 to 100

START: beq $t0, $t9, EXIT # branch if i==100
add $t1, $t1, $t0 # j = j + i

UPDATE: addi $t0, $t0, 1 # i++ 
j START

EXIT:



Homework

§ Fibonacci sequence:
ú How  would you convert this into assembly?

int n = 10;
int f1 = 1, f2 = 1; 

while (n != 0) {
f1 = f1 + f2;
f2 = f1 – f2;
n = n – 1;

}
# result is f1


